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Puji syukur penulis panjatkan kehadirat Tuhan Yang  
Maha Esa karena atas berkat rahmatnya penulis dapat menye
lesaikan Buku Ajar yang berjudul “Analisis Data Kesehatan I”. 

Buku ajar ini bukan sebagai pengganti perkuliahan me
tode penelitian, namun diharapkan dapat menambah pema
haman bagi mahasiswa kedokteran di Fakultas Kedokteran, 
Universitas Surabaya terkait dengan statistika. Materi yang 
dibahas pada buku ajar ini adalah pengenalan statistika, skala 
data, Statistical Product and Service Solutions (SPSS), statistika 
deskriptif dan uji prasyarat. Buku ajar ini berisi mengenai 
tujuan instruksional pembelajaran, materi pembelajaran, dan 
soal latihan. Cara penyelesaian dijabarkan secara bertahap 
sehingga menjadi lebih mudah dipahami oleh mahasiswa. 

Penulis menyadari bahwa penyusunan buku ajar ini masih 
jauh dari sempurna. Berbagai masukkan mengenai buku ajar 
ini akan penulis terima dengan senang hati sebagai perbaikan  
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PENGENALAN 
STATISTIKA1

Latar belakang
Statistika merupakan bagian dari perkuliahan metode 

penelitian bagi mahasiswa di Fakultas Kedokteran, Universitas 
Surabaya. Pemberian materi statistika dilakukan secara ber
tahap setelah mahasiswa mampu memahami materi yang ber
kaitan dengan metode penelitian, teknik sampling dan per
hitungan besar sampel. Hal ini dilakukan agar mahasiswa 
lebih mudah memahami fungsi dan peran dari statistika dalam 
sebuah penelitian.

Tujuan Pembelajaran
Tujuan Instruksional Umum

Setelah mengikuti perkuliahan ini diharapkan mahasiswa 
dapat mengetahui dan memahami tentang statistika.

 
Tujuan Instruksional Khusus

Setelah mempelajari keseluruhan bab ini dan mengikuti 
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Daftar Pustaka
Candra, Budiman. 1995. Pengantar Statistika Kesehatan. 

Jakarta: EGC

Pemerintah Indonesia. 1997. Undang-Undang Republik 
Indonesia Nomor 16 Tahun 1997 Tentang Statistik. 
Lembaran RI tahun 1997. Jakarta: Sekretariat Negara

Santjaka, Aruis. 2011. Statistik Untuk Penelitian Kesehatan. 
Yogyakarta: Nuha Medika

Sunyoto, Danang dan ari Setiawan. 2013. Statistic Kesehatan. 
Yogyakarta: Nuha Medika

Usman, husaini dan Purnomo. 2020. Pengantar statistika, 
Jakarta: Bumi Aksara

Pengenalan Statistika6



Analisis Data Kesehatan
Statistika Dasar Dan Korelasi 9

5. 	 Berdasarkan metodenya statistika dibedakan menjadi 2 
yaitu

	 a. 	 Statistika analitik dan non analitik
	 b. 	 Statistika deskriptif dan inferensial 
	 c. 	 Statistika berjenjang dan tunggal
	 d. 	 Statistika kualitatif dan kuantitatif
	 e. 	 Statistika populasi dan sampel

Jawaban Dan Pembahasan
1. 	 C
	 Kesalahan dalam menentukan metode analisis yang di

gunakan akan mengakibatkan interpretasi hasil pene
litian yang salah, sehingga penilaian data yang telah di
kumpulkan menjadi tidak tepat.

2. 	 A
	 Pengambilan sampel dan perhitungan yang benar dan 

tepat akan mendapatkan hasil yang dapat digeneralisasi. 
Hal ini berarti hasil tersebut telah dapat dikatakan 
mewakili semua populasi dan kesimpulan yang diperoleh 
juga merupakan perwakilan dari populasi secara umum.

3. 	 E
	 Statistika memiliki berbagai peran dan fungsi apabila 

dilakukan secara benar dan tepat. Hal tersebut akan ber
dampak pada pengambilan keputusan yang baik dan hu
bungan antara variabel dapat diketahui, sehingga pem
buatan rencana dalam mengatasi kemungkinan yang 
terjadi dilakukan secara tepat.

4. 	 D
	 Dalam UU no 6 tahun 1997 tentang statistik disebutkan 

bahwa; Statistik adalah data yang diperoleh dengan cara 
pengumpulan, pengolahan, penyajian, dan analisis serta 

Pengenalan Statistika8



Analisis Data Kesehatan
Statistika Dasar Dan Korelasi



Analisis Data Kesehatan
Statistika Dasar Dan Korelasi

Latar belakang
Pemahaman mengenai skala data bagi mahasiswa kedok

teran sangat dibutuhkan. Hal ini dikarenakan skala data pada 
suatu penelitian akan menentukan teknik analisis data dan 
tahapan penelitian selanjutnya. Kesalahan dalam penentuan 
skala data dalam suatu penelitian akan mengakibatkan keti
daksesuaian penggunaan intrumen pengujian atau analisis, 
sehingga dapat memengaruhi hasil hingga kesimpulan pada 
suatu penelitian.

Tujuan Pembelajaran
Tujuan Instruksional Umum

Setelah mengikuti perkuliahan ini diharapkan mahasiswa 
dapat mengetahui dan memahami tentang skala data. 

11

SKALA DATA2
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Tujuan Instruksional Khusus
Setelah mempelajari keseluruhan bab ini dan mengikuti 

perkuliahan, mahasiswa diharapkan mampu:
1. 	 Memahami proses pengambilan data
2. 	 Memahami jenis skala data
3. 	 Mengklasifikasikan data berdasarkan skala data

Menurut Kamus Besar Bahasa Indonesia, data merupakan 
keterangan yang benar dan nyata. Data diperoleh dari suatu 
pengamatan dan dapat memberikan informasi mengenai gam
baran suatu keadaan. 

Tujuan pengumpulan data adalah untuk memperoleh gam
baran suatu keadaan dan sebagai dasar pengambilan keputusan.

Sebagai pengambilan keputusan, data yang diperoleh 
harus disimpulkan dengan benar dan tepat, sehingga data yang 
diambil harus memenuhi syarat :
1. 	 Data harus objektif 
	 Sesuai keadaan yang sebenarnya
2. 	 Data harus representatif
	 Dapat mewakili data lainnya
3. 	 Data harus up to date
	 Terbaru/terupdate
4. 	 Data harus relevan
	 Relevan atau sesuai dengan masalah yang akan dipecahkan
Teknik pengumpulan data
Ada 4 cara dalam pengumpulkan data:
1. 	 Wawancara 
	 Peneliti langsung bertemu dengan responden untuk 

melakukan wawancara langsung. 
2. 	 Pengamatan 
	 Peneliti tidak melakukan tindakan apapun ke responden, 

hanya melakukan pengamatan. Misalnya mengamati 
kebiasaan perokok sehari-hari.

9Skala Data12
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		  2 = perempuan 
		  Angka 1 dan 2 merupakan simbol dan tidak bermakna 
		  2 lebih  besar dari 1 atau  perempuan lebih besar dari 
		  laki-laki.
	 2. 	 Data  ordinal: data  yang  memiliki jenjang atau ting- 
		  katan dan dapat diurutkan dari rendah ke tinggi.
		  Contoh:
		  Tingkat pendidikan:
		  1. SD
		  2. SMP
		  3. SMA
		  SMA  lebih  tinggi  dari  SMP,  SMP  lebih tinggi dari 
		  SD dst
	 3. 	 Data interval: data yang dapat diurutkan dalam krite- 
		  ria  tertentu,  memiliki  jarak  atau  interval  antardata 
		  serta tidak memiliki nilai nol (0) mutlak.
		  Contoh:
		  Pendapatan 
		  1.000.000 – 1.500.000
		  1.500.000 – 2.000.000
		  2.500.000 – 3.000.000
		  Data  pendapatan  di atas  menunjukkan   jarak   atau 
		  interval yang sama.
D. 	 Data rasio: data yang memiliki arti yang sesungguhnya, 

memiliki angka nol (0) mutlak dan dapat dilakukan fungsi 
matematika (“+”, “-“, “x”, “:”)

	 Contoh: 
	 Panjang suatu benda, nilai ujian jumlah penjualan, dst
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Daftar Pustaka
Candra, Budiman. 1995. Pengantar Statistika Kesehatan. 
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Usman, Husaini dan Purnomo. 2020. Pengantar statistika, 
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Latihan Soal
Pilih salah satu jawaban yang paling benar
1. 	 Seorang dokter ingin mengetahui tingkat pengetahuan ibu 

terhadap pola asuh anak melalui pemberian kuesioner. 
Responden diberikan 20 pertanyaan mengenai cara pola 
asuh yang benar. Setiap pertanyaan yang benar akan 
mendapat nilai 5, sehingga nilai maksimal yang dapat 
diperoleh oleh responden adalah 100. Skala data yang 
digunakan pada penelitian ini adalah

	 a. 	 Nominal
	 b. 	 Numerik
	 c. 	 Interval
	 d. 	 Ordinal
	 e. 	 Rasio

2. 	 Suatu penelitian ingin mendeskripsikan karakteristik 
responden terhadap jenis kelamin. Penelitian tersebut 
diikuti oleh 200 responden yang terdiri atas 140 laki-laki 
(70%) dan 60 perempuan (30%).

	 Skala data yang digunakan pada penelitian ini adalah
	 a. 	 Persentase
	 b. 	 Nominal
	 c. 	 Prevalensi
	 d. 	 Interval
	 e. 	 Rasio

3. 	 Hasil suatu kuesioner mengenai tingkat aktivitas fisik 
pada suatu wilayah akan dilakukan klasifikasi menjadi 3 
macam aktivitas yaitu ringan, sedang dan berat. Ketiga 
kategori ini ditentukan dengan menilai berbagai macam 
kegiatan responden sehari-hari. Selanjutnya, data yang 
diperoleh akan disajikan dalam bentuk grafik. 

	 Skala data yang digunakan pada penelitian ini adalah
	 a. 	 Ordinal
	 b. 	 Rasio
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Jawaban Dan Pembahasan
1. 	 E
	 Penilaian kuesioner menggunakan angka dengan range 

nilai 0 – 100 sehingga dapat disimpulkan skala data pada 
penelitian tersebut adalah rasio.

2. 	 B
	 Penelitian tersebut menggunakan 2 kategori yaitu laki-

laki dan perempuan. Keduanya merupakan variabel yang 
tidak memiliki perbedaan dan kedudukan yang berbeda. 
Sehingga dapat disimpulkan skala data yang digunakan 
adalah nominal.

3. 	 A
	 Kuesioner aktivitas fisik melakukan pembagian kategori 

menjadi 3 macam yaitu ringan, sedang dan berat. Ketiga 
variabel tersebut memiliki tingkatan yang dapat diurutkan, 
yakni aktivitas ringan lebih rendah dibandingkan aktivitas 
sedang dan aktivitas sedang lebih rendah dibandingkan 
aktivitas berat. Jadi dapat disimpulkan skala data yang 
digunaka adalah ordinal.

4. 	 E
	 Pertanyaan ini mempertanyakan skala data nominal pada 

pilihan jawaban.
	 l	Riwayat  penyakit:  Keterangan  penyakit  yang  dimilki 
		  oleh responden
	 l	Tekanan darah: Dinyatakan berupa angka (cth. 120/80)
	 l	Kadar gula darah: Dinyatakan  berupa  angka (cth. 150 
		  mg/dl)
	 l	Tingkat pendidikan: Skala data ordinal karena memiliki 
		  tingkatan (cth. SD, SMP, SMA, S1)
	 l	Golongan darah: Skala data nominal, karena  tidak ada 
		  perbedaan dan tingkatan antar-variabel (cth Golongan	

	 darah A, B, AB, dan O)
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5. 	 E
	 Pertanyaan ini mempertanyakan skala data nominal pada 

pilihan jawaban.
	 l	Suku: Skala data nominal, karena tidak  ada  perbedaan 
		  dan tingkatan antar-variabel (cth. Suku Jawa, Bali, Bu- 
		  gis, Batak)
	 l	Riwayat penyakit dahulu: Berupa keterangan penyakit 
		  terdahulu yang dimilki oleh responden
	 l	Jenis  kelamin:  Skala  data  nominal,  karena  tidak  ada 
		  perbedaan dan  tingkatan antar-variabel (cth. Laki-laki 
		  dan Perempuan)
	 l	Tingkat  penghasilan:  Skala  data  rasio, kerna memilki 
		  nilai 0 mutlak  dan berupa angka (cth. Rp. 3.500.000,-/
		  bulan)
	 l	Selisih suhu badan: Skala data interval, karena memilki 
		  jarak antar data dan tidak memiliki nilai mutak

6. 	 B
	 Pertanyaan ini mempertanyakan skala data ordinal pada 

pilihan jawaban.
	 l	Riwayat  penyakit:  Berupa  keterangan  penyakit yang 
		  dimiliki oleh responden
	 l	Derajat keparahan penyakit: Skala data Ordinal, karena 
		  memiliki tingkatan antar-variabel (cth. Parah atau tidak 
		  parah; baik atau buruk dll)
	 l	Kadar  gula  darah: Skala data rasio, karena dinyatakan 
		  berupa angka (cth. 150 mg/dl)
	 l	Kadar  kolesterol: Skala  data rasio, karena dinyatakan 
		  berupa angka (cth. 200 mg/dl)
	 l	Ras: Skala  data  nominal, karena  tidak ada perbedaan 
		  dan tingkatan antar-variabel (cth. Ras Melayu, Papua dll)



Analisis Data Kesehatan
Statistika Dasar Dan KorelasiSkala Data28

7. 	 C
	 Pertanyaan ini mempertanyakan skala data rasio pada 

pilihan jawaban.
	 l	Diagnosa  Penyakit: Berupa keterangan penyakit yang 
		  dimiliki oleh responden
	 l	Tingkat aktivitas fisik: Skala  data Ordinal, karena me- 
		  miliki tingkatan antar variabel (cth. Rendah, cukup dan 
		  berat)
	 l	Kadar gula darah: Skala  data rasio, karena dinyatakan 
		  berupa angka (cth. 150 mg/dl)
	 l	Riwayat  pengobatan: Berupa  keterangan  pengobatan 
		  yang dimiliki oleh responden
	 l	Agama: Skala data nominal, karena tidak ada perbedaan 
		  dan tingkatan antar variabel (cth. Islam, Kristen, Kato- 
		  lik, Hindu, Budha dll)

8. 	 B
	 Skala data rasio terdapat pada kadar radikal bebas, dika

renakan pengukuran radikal bebas dinyatakan berupa 
angka.

9. 	 C
	 Skala data nominal terdapat pada kota asal pengemudi, 

dikarenakan kota asal tidak menjadi pengaruh dari 
penelitian dan memiliki kedudukan yang sama atau tanpa 
tingkatan antara ota satu dengan yang lain.

10. 	 D
	 Skala data nominal terdapat pada kota asal pengemudi, 

dikarenakan kota asal tidak menjadi pengaruh dari 
penelitian dan memiliki kedudukan yang sama atau tanpa 
tingkatan antara kota satu dengan yang lain.



Analisis Data Kesehatan
Statistika Dasar Dan Korelasi 29

11. 	 C
	 Jenis kelamin merupakan skala data nominal, dikarenakan 

variabel jenis kelamin (laki-laki dan perempuan) tidak 
memiliki tingkatan atau dapat dikatakan setara.

12. 	 A
	 Berat badan dalam kilogram merupakan skala rasio, dika

renakan berat badan pada pertanyaan tersebut dinyatakan 
dalam angka (cth. 35 kilogram).

13. 	 D
	 Pengambilan data harus berdasarkan fakta dan kenyataan 

yang ada, tidak boleh mencari data yang hanya sesuai 
keinginan peneliti, sehingga pengambilan data yang 
relevan merupakan syarat pengambilan data.

14. 	 D
	 Pengumpulan data harus sesuai dan tepat serta dapat di

pertanggungjawabkan, sehingga data yang diambil harus 
bersifat obyektif. Pengumpulan data dengan menggu
nakan penilaian yang dibuat sendiri tanpa melalui proses 
validasi dan reliabilitas dapat menimbulkan bias dan 
bersifat subjektif.

15. 	 D
	 Salah satu cara pengambilan kuesioner dapat dilakukan 

secara tertutup. Proses pengambilan kuesioner tertutup 
merupakan pertanyaan yang sudah disediakan pilihan 
jawaban oleh peneliti, sehingga responden dapat langsung 
memilih jawaban yang sudah tersedia. 

16. 	 A
	 Jenis kelamin merupakan skala data nominal karena tidak 

terdapat tingkatan atau setara antar-variabel
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17. 	 A
	 Pertanyaan ini mempertanyakan skala data rasio pada 

pilihan jawaban.
	 l	Tingkat pendapatan: Skala data rasio, karena dinyatakan 
		  berupa angka
	 l	Angka kesakitan: skala data ordinal, karena telah dika- 
		  tegorikan tinggi dan rendah
	 l	Puskesmas: merupakan tempat pengambilan sampel
	 l	Nama responden: merupakan  keterangan  atau biodata 
		  responden
	 l	Agama: Skala data nominal, karena tidak ada perbedaan 
		  dan tingkatan antar variabel (cth. Islam, Kristen, Kato- 
		  lik, Hindu, Budha dll)

18. 	 C
	 Telah dijelaskan pada soal nomer 17

19. 	 B
	 Telah dijelaskan pada soal nomer 17

20. 	 B
	 Dapat dilihat pada gambar 2.1
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Latar belakang
Statistical Product and Service Solutions (SPSS) meru

pakan salah satu program pengolahan data yang cukup popular 
dan sering digunakan. Cara pengoperasiannya yang mudah 
juga menjadi salah satu faktor yang berpengaruh. Mahasiswa 
kedokteran pada umumnya melakukan topik penelitian yang 
berhubungan dengan pengujian laboratorium, kesehatan di 
masyarakat dan pengambilan data sekunder. Pengolahan data 
dari ketiga topik tersebut dapat menggunakan program SPSS. 
Oleh karena itu, pemahaman dan kemampuan pengoperasian 
Statistical Product and Service Solutions (SPSS) diperlukan 
bagi mahasiswa kedokteran.  

Tujuan Pembelajaran
Tujuan Instruksional Umum

Setelah mengikuti perkuliahan ini diharapkan mahasiswa 

STATISTICAL PRODUCT 
AND SERVICE SOLUTIONS 
(SPSS)

3
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Statistical Product And 
Service Solutions (SPSS)34

4. 	 Tampilan data view dalam Statistical Product and Service 
Solutions (SPSS)

Gambar 3.4 Tampilan data view SPSS.

Keterangan:
a. 	 Menu Bar: perintah dasar untuk mengoperasikan SPSS
b. 	 Tool Bar: perintah yang digunakan dalam pengoperasian 

SPSS dalam bentuk gambar
c. 	 Data bar: Tempat untuk membantu menuliskan data pada 

cell
d. 	 Name cell (column): Nama untuk variabel pada setiap cell 

per column
e. 	 Column dan row (cell): Tempat untuk menuliskan data 

yang akan diolah
f. 	 Data view: Halaman untuk menginput data
g. 	 Variabel view: Halaman untuk mendefinisikan variabel
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Statistical Product And 
Service Solutions (SPSS)42

Gambar 3.16 Tampilan align pada data view.

3.5 	 Penentuan measure
Bertujuan menentukan skala data penelitian yang diolah, 
seperti Scale (ratio dan interval), Ordinal dan Nominal

Gambar 3.17 Tampilan measure pada data view.
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Service Solutions (SPSS)46

JAWABAN

1.
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Latar belakang
Statistika deskriptif merupakan proses analisis data yang 

paling mendasar. Perhitungan hasil penelitian (measure of 
central tendency) dan penyajian data dengan menggunakan 
model grafik menjadi komponen pembelajaran utama pada 
perkuliahan ini. Sebagian besar mahasiswa kedokteran 
akan menggunakan statistika deskriptif dalam menerangkan 
distribusi karakteristik pada penelitiannya. Penyajian dan 
perhitungan data penelitian secara tepat dan benar dibutuhkan 
oleh mahasiswa kedokteran dalam melakukan suatu penelitian.     

Tujuan Pembelajaran
Tujuan Instruksional Umum

Setelah mengikuti perkuliahan ini diharapkan mahasiswa 
dapat memahami mengenai statistika deskriptif. 

STATISTIKA 
DESKRIPTIF4
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Tujuan Instruksional Khusus
Setelah mempelajari keseluruhan bab ini dan mengikuti 

perkuliahan, mahasiswa diharapkan mampu:
1. 	 Memahami statistika deskriptif
2. 	 Menyajikan data dengan berbagai macam bentuk grafik
3. 	 Menghitung data tunggal dan berkelompok (measure of 

central tendency) menggunakan SPSS
Statistik deskriptif adalah salah satu bagian dari ilmu 

statistika yang berhubungan dengan aktivitas penghimpunan, 
penataan, peringkasan dan penyajian data dengan tujuan 
agar data lebih bermakna, mudah dibaca dan dipahami oleh 
pengguna data. Statistik deskriptif hanya memberikan deskripsi 
atau gambaran umum tentang karakteristik objek yang diteliti.
Manfaat statistika deskriptif:
1. 	 Mendiskripsikan atau menggambarkan sebuah data yang 

dimiliki.
	 Peneliti haruslah mampu menjelaskan atau menggambar

kan data yang sudah diperoleh. Daripada hanya meng
gunakan angka-angka, menampilkan data dengan grafik/
tabel akan lebih menarik dan mudah dipahami.

2. 	 Menjelaskan karateristik sebuah data
	 Mengerti tentang karateristik data sangatlah penting kare

na akan menentukan jenis analisis yang akan digunakan 
nantinya.

Penyajian data dalam statistika deskriptif ada 2 macam:
1. 	 Tabel 
	 Tabel bertujuan untuk meringkas atau merekap data kuali

tatif, kuantitatif, maupun tabulasi silang.
2. 	 Grafik atau diagram
	 Penyajian data dalam bentuk grafik atau diagram bertujuan 

untuk eksplorasi data, diagram dan sebaran data.

Statistika Deskriptif50
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7. 	 Diagram scatter 

Jenis ukuran dalam statistika deskriptif :
1. 	 Ukuran pemusatan
	 Ukuran pemusatan digunakan untuk menggambarkan 

data dari titik pusat. Ada 3 jenis dalam ukuran pemusatan:
	 a. 	 Mean 
		  Mean merupakan rata – rata dari data.
	 b. 	 Median 
		  Median merupakan nilai tengah dari data.
	 c. 	 Modus 
		  Modus  merupakan  nilai  yang  paling  sering  muncul 
		  dari data.

Contoh kasus:
Seorang peneliti ingin mengetahui gambaran data mean, 
median dan modus data BB bayi di posyandu Sentosa. 
Hasil pengumpulan data diperoleh:
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3. 	 Pilih data yang akan diukur, pindahkan ke sebelah ka- 
	 nan dengan klik tanda panah → klik statistics 

Gambar 4.3 Tampilan frequencies.

4. 	 Pilih mean, median dan modus
	 Pilih “Continue” → “OK”

Gambar 4.4 Tampilan frequencies statistics.
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Gambar 4.5 Pembagian quartile range.

c. 	 Persentil
	 Persentil merupakan penyebaran yang membagi data 
	 menjadi 100 bagian sama besar.
d. 	 Desil 
	 Desil  merupakan  penyebaran   yang  membagi  data  
	 menjadi 10 bagian sama besar.
e. 	 Varians
	 Varians merupakan seberapa jauh data yang kita mili- 
	 ki menyebar dari  nilai rata-rata. Semakin  kecil  nilai 
	 varians, semakin dekat sebaran data dengan rata-rata. 
	 Semakin  besar  nilai  varian,  semakin  besar  sebaran 
	 data terhadap nilai rata-ratanya.
f. 	 Standar deviasi
	 Standar  deviasi   atau   simpangan   baku  merupakan  
	 ukuran lain  dari  sebaran  data terhadap rata-ratanya. 
	 Sama seperti varians, namun standar deviasi mengha- 
	 silkan nilai yang lebih kecil.
g. 	 Skewness
	 Skewness  merupakan  kemencengan  atau  ketidaksi- 
	 metrisan sebuah data terhadap rata–ratanya. 
	 Ada 3 jenis skewness:
	 Sk > 0: kurva menceng kanan (negatif)
	 Sk = 0: kurva normal 
	 Sk < 0: menceng kiri (positif)
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Berapakah nilai range, persentile, standar deviasi, skewness 
dan kurtosis data BB bayi tersebut?

1. 	 Prosedur:
	 Masukkan data 

Gambar 4.8 Tampilan input data.
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4. 	 Pilih range, persentile, standar deviasi, skewness dan 
kurtosis → “continue”

Gambar 4.11 Tampilan frequencies statistics.

5. Pilih “Charts” → tentukan yang dikehendaki (disini saya 
memilih histograms) → “Continue” → “OK”

Gambar 4.12 Tampilan frequencies charts.
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Dari hasil di atas maka didapat hasil:
	Range = 1,7 
	Persentile 

	Varians = 0,254
	Standar deviasi = 0,2543
	Skewness = 0, 658, karena nilai skewness > 0, maka kurva 

menceng kanan (negatif)
	Kurtosis = 0,561, karena nilai kurtosis < 3 maka bentuk 

curva memiliki distribusi platikurtik (lebih rata)
	Tabel histogram menunjukkan persebaran data BB bayi
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4. 	 Hitunglah nilai skewness dan jelaskan 

5.	 Gambarlah bentuk kurva kurtosis yang memiliki nilai 
kurtosis > 3 (leptokurtic)?

51Statistika Deskriptif66
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JAWABAN

1.

2.

3. 	 D

4. 

Nilai skewness = 0,387, karena nilai skewness > 0 maka 
kurva menceng ke arah kanan (negatif)
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Latar belakang
Uji prasyarat dilakukan untuk mengetahui data yang 

diperoleh memenuhi persyaratan untuk dilakukan pengujian 
dengan teknik analisis tertentu. Pada setiap pengujian 
memiliki beberapa persyaratan yang harus dipenuhi, sehingga 
mahasiswa kedokteran diharapkan mampu untuk menggunakan 
uji prasyarat dan menginterpretasikan secara benar dan tepat. 
Kesalahan dalam melakukan uji prasyarat akan berpengaruh 
pada penggunaan jenis teknik analisis hingga kesimpulan dari 
suatu penelitian.    

Tujuan Pembelajaran
Tujuan Instruksional Umum

Setelah mengikuti perkuliahan ini diharapkan mahasiswa 
dapat memahami mengenai berbagai uji prasyarat (normalitas, 
homogenitas, validitas dan reliabilitas). 

UJI
PRASYARAT5
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correlation bernilai negatif maka item pertanyaan disebut 
tidak valid.

- 	 Jika nilai sig. (2-tailed) > α = 5% (0,05) maka item 
pertanyaan disebut tidak valid.

Contoh Kasus:
Seorang mahasiswa kedokteran Universitas Surabaya me

lakukan tingkat pengetahuan mengenai pentingnya Pemberian 
ASI Eksklusif pada Wanita Usia Subur di Desa A. Penilaian 
dilakukan menggunakan kuesioner sebanyak 10 pertanyaan 
dan setiap soal akan dinilai benar atau salah. Mahasiswa 
melakukan proses validasi pada kuesioner tersebut dengan cara 
diberikan kepada 10 orang terlebih dahulu. Setiap pertanyaan 
akan dilakukan koding untuk dianalisis oleh SPSS. Pertanyaan 
yang benar akan diberikan koding “2”, sedangkan jawaban 
yang salah akan diberikan koding “1” (pemilihan angka pada 
koding tergantung dari tiap peneliti).

Prosedur:
1. 	 Masukkan nama variabel yang mewakili tiap soal dan 

total keseluruhan pada Variable View.

Gambar 5.1 Tampilan variable view pada SPSS.
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Gambar 5.2 Tampilan data view pada SPSS.

3. 	 Pilih Analyze → Correlate → Bivariate

Gambar 5.3 Tampilan analisis data pada SPSS.
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5. 	 Hasil Uji Validitas

Tabel 5.3 Hasil uji Validitas

Cara membaca nilai validitas:
1. 	 Dengan melihat nilai sig (2-tailed) dan membandingkan 

dengan nilai α = 5%, dengan melihat nilai total:
	 - 	 Butir   pertanyaan   soal   1   mempunyai   nilai    sig. 
		  (2-tailed) = 0,760, dapat dikatakan nilai sig (2-tailed) 
		  = 0,760 > α (0,05) berarti tidak valid.
	 - 	 Butir   pertanyaan    soal   2   mempunyai   nilai   sig. 
		  (2-tailed) = 0,018, dapat dikatakan nilai sig (2-tailed) 
		  = 0,018 < α (0,05) dan  nilai pearson correlation ber- 
		  nilai positif maka berarti valid.
	 - 	 Butir    pertanyaan    soal   3   mempunyai   nilai   sig. 
		  (2-tailed) = 0,760, dapat dikatakan nilai sig (2-tailed) 
		  = 0,760 > α (0,05) berarti tidak valid.
	 - 	 Dst
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Gambar 5.5 Input data pada data view pada uji reliabilitas.

3. 	 Pilih Analyze → Scale → Reliability Analysis

Gambar 5.6 Langkah SPSS reliabilitas.

4. 	 Pindakan variabel soal ke sebelah kanan pada colom 
“Items” tanpa menyertakan Total. Pada model, pilihlah 
Alpha (yang berarti menggunakan uji Cronbach Alpha)

Uji Prasyarat78
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5.3 	 Normalitas
Uji normalitas merupakan analisis data yang bertujuan 

untuk menilai sebaran data sebuah kelompok pada penelitian. 
Penilaian dilakukan untuk melihat data yang akan diuji pada 
tahap selanjutnya memiliki distribusi yang normal atau tidak. 
Hal tersebut digunakan untuk menentukan apakah data yang 
diambil untuk mewakili populasi dalam penelitian. Pada 
SPSS terdapat beberapa cara untuk melakukan uji normalitas 
yaitu dengan Kolmogorov Smirnov (Lilliefors) dan Shapiro 
Wilk. Skala data yang digunakan pada pengujian ini adalah 
parametrik (interval dan ratio). Hasil uji normalitas dapat 
disimpulan berdistribusi normal apabila nilai p value lebih 
besar dari 0,05.

Contoh Kasus:
Seorang dokter puskesmas ingin menganalisis adanya per

bedaan tingkat pengetahuan sebelum dan sesudah pemberian 
penguluhan pada kader posyandu. Sebelum melakukan ana
lisis, dokter tersebut ingin mengetahui bahwa data yang dia 
peroleh sudah berdistribusi normal.

Uji Prasyarat80
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d. 	 Pindahkan variabel data sebelum dan sesudah pengetahuan 
pada kolom kiri ke kolom kanan.

Gambar 5.11 Pemindahan data yang akan dilakukan uji normalitas.

e. 	 Pilih “Normal” pada Test Distribution

Gambar 5.12 Perhitungan uji normalitas.
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d 	 Pindahkan variabel data sebelum dan sesudah pengetahuan 
pada kolom kiri ke kolom kanan.

Gambar 5.14 Pemindahan data yang akan dilakukan uji normalitas.
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5.4 	 Homogenitas
Uji homogenitas merupakan analisis data yang bertujuan 

untuk varians data pada dua kelompok atau lebih. Pengujian 
ini termasuk salah satu syarat yang harus dilakukan pada 
beberapa jenis uji dengan skala data parametrik (interval dan 
ratio) seperti T-test, Anova, Manova dan korelasi pearson.  
Hasil uji dapat disimpulkan memiliki varians data yang sama 
atau homogen apabila nilai p value lebih besar dari 0,05 (5%).
Contoh Kasus:

Seorang dokter puskesmas ingin menganalisis adanya per
bedaan tingkat pengetahuan sebelum dan sesudah pemberian 
penguluhan pada kader posyandu. Sebelum melakukan ana
lisis, dokter tersebut ingin mengetahui bahwa data yang dia 
peroleh sudah homogen.

Data nilai tingkat pengetahuan:

Tabel 5.8 Contoh Kasus Pada Uji Homogenitas
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Gambar 5.17 Penulisan value labels

Pilih “Add”

Gambar 5.18 Hasil penulisan value labels
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3. 	 Masukkan pada kolom responden berdasarkan koding 
yang telah di-input.

Gambar 5.19 Input data pada data view.

Pilih “View” → “Value Labels”

Uji Prasyarat90
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5. 	 Masukkan “Nilai_Pengetahuan” pada Dependent List 
dan “Responden” pada Factor.

Gambar 5.22 Pemindahan data pada uji homogenitas.

Uji Prasyarat92
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JAWABAN DAN PEMBAHASAN

1.	 E
	 Uji normalitas ada 2 pilihan yaitu Uji Kolmogorov 

Smirnov dan Uji Shapiro Wilk. Namun perbedaan 
keduanya adalah syarat jumlah sampel yang digunakan 
pada penelitian tersebut. Uji Kolmogorov smirnov 
lebih tepat digunkan pada jumlah sampel lebih dari 50, 
sedangkan Uji Shapiro Wilk digunakan pada sampel yang 
berjumlah lebih kecil atau sama dengan 50.

2. 	 E
	 Pada penelitian tersebut, peneliti ingin menguji data 

dengan skala data ordinal atau non parametrik. Pengujian 
uji komparasi atau uji beda pada skala data non parametrik 
tidak membutuhkan uji prasyarat atau pengujian awal 
seperti uji normalitas (Shapiro Wilk) dan uji Homogenitas. 
Sedangkan uji validitas dan uji reliabilitas biasanya 
digunakan pada proses validitas kuesioner.

3. 	 C
	 Uji Shapiro Wilk: Salah satu jenis uji normalitas
	 Uji Spearman: Uji korelasi pada skala data ordinal
	 Uji Cronbach alpha: salah satu jenis uji reliabilitas yang 

paling sering digunakan pada penelitian
	 Uji Anova Oneway: Uji Komparasi pada skala data 

parametrik
	 Uji Pearson: Uji korelasi pada skala data parametrik

4. 	 A
	 Pada penelitian tersebut, ditemukan
	 l	 Kuesioner  tingkat  pengetahuan  bertujuan  memban- 
		  dingkan  2  kelompok  berbeda,   sehingga  penilaian 
		  kuesioner bukan pre dan post pada satu kelompok.
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	 l	 Kuesioner tingkat pengetahuan yang  memiliki perhi- 
		  tungan nilai 0-100, sehingga dapat disimpulkan skala 
		  data merupakan parametrik dan tidak memilki katego- 
		  risasi atau pengelompokan.
	 l	 Nilai p pada uji normalitas adalah 0,348 (p>0,05), se- 
		  hingga dikatakan data berdistribusi normal.
	 l	 Nilai p  pada uji  homogenitas adalah  0,012 (p<0,05) 
		  sehingga dapat dikatakan data bersifat tidak homogen 
		  atau heterogen.

5. 	 E
	 Pertanyaan tersebut menyatakan bahwa kuesioner terse

but dilakukan penilaian untuk mengetahui ada tidaknya 
perbedaan antara kedua kelompok. Ibu yang dapat men
jawab lebih dari 50% soal akan dikategorikan pola asuh 
baik, sedangkan sisanya akan dikategorikan pola asuh 
buruk, sehingga dapat disimpulkan skala data pada pe
nelitian tersebut adalah ordinal (non parametrik). Hal 
tersebut menunjukkan bahwa uji prasyarat atau uji awal 
tidak dibutuhkan, sehingga uji beda (uji komparasi) dapat 
langsung dilakukan.

6. 	 C
	 Pada tabel tersebut memperlihatkan hasil uji validitas 

dari suatu kuesioner. Untuk mengetahui nilai tersebut 
valid atau tidak. Langkah pertama adalah melihat nilai 
sig. (2-tailed), apabila nilai p-nya < 0,05, maka data 
dapat dikatakan valid. Selanjutnya langkah kedua 
membandingkan nilai pada pearson correlation dengan 
nilai p pada tabel atau pada SPSS dapat dilihat tanda * 
(cth 0,881*).
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7. 	 C
	 Pada uji reliabilitas yaitu Cronbach alpha, hasil penelitian 

dapat dikatakan reliabel bila pada perhitungan mendapat 
nilai diatas 0,6.

8. 	 B 
	 Pada penelitian tersebut, menyatakan
	 l	 Kuesioner tingkat pengetahuan memiliki nilai 0-100, 
		  sehingga  skala  data  penelitian tersebut adalah para- 
		  metrik
	 l	 Uji     reliabilitas    memperlihatkan,    nilai  p=0,818 
		  (p>0,600), sehingga kuesioner dapat dikatakan reliabel
	 l	 Uji normalitas memperlihatkan nilai p=0,121 (p>0,05), 
		  sehingga dpaat dikatakan data penelitian berdistribusi 
		  normal
	 l	 Uji    homogenitas    memperlihatkan   nilai   p=0,045 
		  (p<0,05), sehingga dapat dikatakan data bersifat tidak
		  homogen
	 l	 Penggunaan  uji beda  pada skala data parametrik de- 
		  ngan 2 kelompok hanya harus memenuhi persyaratan 
		  yaitu data berdistribusi normal

9. 	 A
	 Uji normalitas ada 2 pilihan yaitu Uji Kolmogorov 

Smirnov dan Uji Shapiro Wilk. Namun perbedaan 
keduanya adalah syarat jumlah sampel yang digunakan 
pada penelitian tersebut. Uji Kolmogorov smirnov 
lebih tepat digunkan pada jumlah sampel lebih dari 50, 
sedangkan Uji Shapiro Wilk digunakan pada sampel yang 
berjumlah lebih kecil atau sama dengan 50.
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10. 	 C
	 Pada hasil penelitian tersebut memperlihatkan jumlah 

sampel yang digunakan adalah 40 orang per kelompok 
(lebih kecil dari 50), sehingga uji yang digunakan adalah 
uji Shapiro Wilk. Penentuan hasil uji pada SPSS dengan 
melihat nilai sig. pada kolom “Shapiro Wilk” dan pada 
baris dari “Nilai Kelas_A”.
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Latar belakang
Uji korelasi suatu analisis data yang digunakan untuk 

mengetahui hubungan atau tingkat keeratan antara kedua data 
penelitian. Penggunaan uji korelasi juga terdapat beberapa 
persyaratan yang akan menentukan jenis uji yang digunakan. 
Mahasiswa kedokteran diharapkan mampu untuk memahami 
dan menggunakan uji korelasi serta dapat menginterpretasikan 
secara benar dan tepat. Kesalahan dalam menggunakan dan 
menginterpretasikan uji korelasi akan berpengaruh pada hasil 
penelitian dan kesimpulan dari suatu penelitian.    

Tujuan Pembelajaran
Tujuan Instruksional Umum

Setelah mengikuti perkuliahan ini diharapkan mahasiswa 
dapat memahami, menggunakan dan menginterpretasikan 
berbagai uji korelasi melalui program SPSS. 

UJI
KORELASI6
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Hubungan besar kecilnya antara kedua variabel dinyata
kan dalan koefisiensi korelasi yang memiliki nilai 0 ± 1. Hasil 
pengujian korelasi yang menunjukkan angka +/- 1 meng
gambarkan hubungan yang erat atau sempurna antara kedua 
variabel, sedangkan angka 0 (nol) dianggap tidak adanya 
hubungan antara kedua variabel. Oleh karena itu dapat disim
pulkan bahwa pada hasil uji korelasi semakin mendekati angka 
0 (nol), maka hubungan antara kedua variabel semakin kecil.

Tanda “+” (positif) atau “–“ (negatif) pada hasil uji 
korelasi menunjukkan arah hubungan kedua variabel. Tanda 
“+” memperlihatkan adanya hubungan positif yang diartikan 
bahwa peningkatan suatu variabel akan diikuti dengan 
peningkatan variabel lainnya, sedangkan tanda “–“ merupakan 
hubungan negatif yang memperlihatkan hasil yang berlawanan 
antara kedua variabel.
Cara Membaca Nilai Koefisien Korelasi

Gambar 6.1 Arah korelasi.

Pada koefisien korelasi bernilai -1 sampai 1, semakin 
mendekati -1 atau 1 maka korelasi semakin kuat, sedangkan 
mendekati 0 maka (nol) maka korelasi semakin lemah.

Pada analisis korelasi biasanya tidak dikenal variabel 
dependen dan independen (keterkaitan), sehingga dapat 
diartikan bahwa kedua variabel yang akan dilakukan pengujian 
bersifat independen. Keduanya saling berdiri sendiri dan 
tidak memiliki ketergantungan satu sama lain. Hal ini dapat 
disimpulkan hubungan variabel pertama dan kedua sama 
dengan hubungan variabel kedua dan pertama. Nilai koefisiensi 
yang kecil (tidak memiliki hubungan korelasi yang kuat), 
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Pertanyaan:
Apakah ada hubungan antara BB ibu dengan berat badan bayi 
lahir dan berapa kuat hubungan tersebut?

Prosedur:
1. 	 Masukkan nama variabel “BB ibu” dan “BB bayi lahir” 

pada Variable View.

Gambar 6.2 Tampilan variabel view pada SPSS.

2. 	 Masukkan data pada Data View

Gambar 6.3 Tampilan data view pada SPSS.
*) Data diasumsikan berdistribusi normal dan homogen.
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4. 	 Hasil uji pearson

Hasil di atas didapat nilai Sig.(2-tailed) sebesar 0,740 
(p>0,05; α=5%) maka dapat disimpulkan bahwa tidak ada 
hubungan yang signifikan antara berat badan ibu dengan berat 
badan bayi lahir.

Untuk kuat hubungan, dari tabel hasil di atas diperoleh 
nilai koefisien pearson sebesar 0.121 yang berarti terdapat 
hubungan lemah antara BB Ibu dengan BB bayi lahir.

6.2 	 Korelasi Spearman
Suatu uji yang digunakan untuk menganalisis hubungan 

antara 2 variabel penelitian, dengan skala data non-parametrik 
(skala data ordinal / skala data ratio atau interval tetapi tidak 
berdistribusi normal). Dikarenakan uji Spearman digunakan 
pada skala data non-parametrik maka tidak dibutuhkan syarat 
pengujian awal seperti uji normalitas dan homogenitas. 
Namun, penggunaan uji ini harus berasal dari subjek berbeda 
atau tidak berpasangan antara kedua kelompok.
Contoh Kasus:

Seorang dokter puskesmas ingin menganalisis kesejah
teraan bayi di wilayahnya dengan menganalisis hubungan 
antara berat badan bayi (umur 1 tahun) dengan pengeluaran 
untuk konsumsi setiap harinya. 
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2. 	 Masukkan data pada Data View

Gambar 6.7 Tampilan data view pada SPSS.

*) Data diasumsikan tidak berdistribusi normal 

3. 	 Lakukan analisis dengan langkah berikut :

Pilih “Analyze” → “Correlate” → “Bivariate”

Gambar 6.8 Tampilan analisis data pada SPSS.
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6.3 	 Korelasi Kendall_Tau
Suatu uji yang digunakan untuk menganalisis hubungan 

antara variabel penelitian dengan skala data non-parametrik 
(minimal ordinal). Persyaratan penggunaan uji kendall tau 
yaitu tidak dibutuhkan pengujian awal seperti uji normalitas 
dan homogenitas. Namun yang membedakan adalah pada 
uji Kendall Tau digunakan untuk subjek yang sama atau 
berpasangan.

Korelasi Kendall Tau ada 2 macam, yaitu Kendall Tau b 
dan Kendall Tau c. Uji korelasi Kendall Tau b digunakan untuk 
data dengan tabel kontingensi square. Artinya square jumlah 
baris dan kolom sama, contoh:  2x2, 3x3, dst. Sedangkan 
Kendall Tau c digunakan untuk data dengan tabel kontingensi 
selain square, contoh: 2x3, 3x4, dst.

Contoh Kasus 1:
Seorang dokter puskesmas ingin menganalisis hubungan 

tingkat pengetahuan saat penyuluhan tentang bahaya merokok 
terhadap status kesehatan anak SMA. Penilaian tingkat 
pengetahuan dikategorikan menjadi 2 yaitu baik dan buruk, 
sedangkan status kesehatan dikategorikan menjadi 2 yaitu 
sehat dan tidak sehat.

115

Kendall Tau cKendall Tau b



Analisis Data Kesehatan
Statistika Dasar Dan Korelasi

Pindahkan data dari kolom kiri ke kanan, pilih “Kendall_tau” 
→ “OK”

Gambar 6.14 Tampilan Bivariate Correlations pada SPSS.

5. 	 Hasil uji Kendall’s Tau

Hasil di atas didapat nilai Sig.(2-tailed) yaitu 0,016, karena 
nilai sig. < 0,05 (α=5%) maka dapat diambil kesimpulan ada 
hubungan yang signifikan antara tingkat pengetahuan dengan 
status kesehatan.

Untuk kuat hubungan, dari tabel hasil di atas diperoleh 
nilai koefisien kendall_tau sebesar 0.802 yang artinya ada 
hubungan sangat kuat antara tingkat pengetahuan dengan 
status kesehatan.
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Tabel kontingensi menunjukkan bentuk square (3x2), 
maka yang digunakan adalah uji Kendall Tau c.

Prosedur Kendall Tau C
1. 	 Masukkan nama variabel pada Variable View.

Gambar 6.15 Tampilan variabel view pada SPSS.

2. 	 Berikan koding pada Kedua Kelompok pada Value 
Labels.

Tingkat Pengetahuan	 : 	Buruk (3); Sedang (2); Baik (1)
Status Kesehatan	 : 	Tidak Sehat (2); Sehat (1)
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4. 	 Lakukan analisis dengan langkah berikut:

Pilih “Analyze” → “Descriptive statistic” → “Crosstab” 

Gambar 6.18 Tampilan analisis data pada SPSS.

Row	 :	 Tingkat Pengetahuan 
Column	 :	 Status Kesehatan

Gambar 6.19 Tampilan Crosstabs pada SPSS.
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Pada tabel “Tingkat Pengetahuan * Status kesehatan 
Crosstabulation” menunjukkan hasil tabel kontingensi dari 
data yang telah dimasukkan. Hasil tersebut cocok dengan tabel 
kontingensi pada contoh kasus di atas.

Hubungan antara tingkat pengetahuan dengan status kese
hatan dilihat pada nilai signifikansi (approximate significance) 
sebesar 0,000. Dikarenakan nilai sig. 0,000 (p<0,05; α=5%) 
maka dapat disimpulkan bahwa terdapat hubungan yang 
signifikan antara tingkat pengetahuan dengan status kesehatan. 
Hasil koefisien korelasi kendall tau c diatas didapat nilai yaitu 
0,942, termasuk hubungan yang sangat kuat antara kedua 
kelompok.

6.4 	 Gamma
Suatu uji yang digunakan untuk menganalisis hubungan 

antara variabel penelitian dengan skala data non-parametrik. 
Uji korelasi gamma memiliki skala data ordinal, ratio atau 
interval tetapi tidak berdistribusi normal. Uji korelasi 
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Berikut data yang didapat:

Data yang diperoleh jika dibuat tabel kontingensi maka 
hasilnya:
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Gambar 6.22 Tampilan Value Labels pada SPSS

3.	 Masukkan data pada Data View

Gambar 6.23 Tampilan data view pada SPSS

4. 	 Lakukan analisis dengan langkah berikut:

Pilih “Analyze” 
Pilih “Descriptive Statistic” 
Pilih “Crosstab” 
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Pilih “Statistic” → “Gamma” → “Continue” → “OK”

Gambar 6.26 Tampilan Crosstabs: Statistics pada SPSS

5. 	 Hasil uji gamma

Tabel “Case Processing Summary” pada kolom “Valid” 
memperlihatkan nilai N yang menginterpretasikan jumlah 
data yang diolah (sebesar 25).  Hal ini sesuai dengan data yang 
diinput pada Data view. Sedangkan pada kolom “Missing” 
memperlihatkan nilai N yang menginterpretasikan jumlah data 
yang hilang atau tidak diolah (sebesar 0). Hal ini disimpulkan 
bahwa pada uji korelasi ini tidak terdapat data yang hilang atau 
semua data diolah. 
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6.5 	 Somer’s D
Suatu uji yang digunakan untuk menganalisis hubungan 

antara variabel penelitian dengan skala data non-parametrik. 
Persyaratan penggunaan uji Somer’s D yaitu tidak dibutuhkan 
pengujian awal seperti uji normalitas dan homogenitas. Uji 
somers’s D memerlukan skala data ordinal / skala data ratio 
atau interval tetapi tidak berdistribusi normal. Namun yang 
membedakan adalah pada uji Somer’s D data yang digunakan 
saling dipengaruhi mempengaruhi dan antar variabel terdapat 
keterkaitan satu sama lain.
Contoh kasus:

Seorang dokter puskesmas ingin menganalisis adanya hu
bungan antara tingkat Pendidikan dengan tingkat pengetahuan 
terhadap asupan makanan bergizi pada anak. Responden 
yang merupakan ibu yang telah memiliki anak dilakukan 
pendataan tingkat Pendidikan dan diberikan kuesioner yang 
berisi beberapa pertanyaan terkait dengan pengetahuan asupan 
makanan bergizi pada anak. Nilai pada kuesioner dikategorikan 
menjadi 2 bagian yaitu baik dan buruk.
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Pertanyaan:
Apakah ada hubungan antara tingkat pendidikan dengan 
tingkat pengetahuan dan berapa kuat hubungan tersebut?

Prosedur:
1. 	 Masukkan nama variabel tingkat pendidikan “TP” dan 

tingkat pengetahuan “TH” pada Variable View. 

Gambar 6.27 Tampilan variabel view pada SPSS

2. 	 Berikan koding pada Kedua Kelompok pada Value 
Labels.

Tingkat_Pendidikan	 :	 SMA (1); S1 (2)
Tingkat_Pengetahuan	 :	 Buruk (1); Baik (2) 
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4. 	 Lakukan analisis dengan langkah berikut:
Pilih “Analyze” 
Pilih “Descriptive Statistic”
Pilih “Crosstab” 

Gambar 6.30 Tampilan analisis data pada SPSS

Row	 :	 Tingkat Pendidikan 
Column	 :	 Tingkat Pengetahuan

Gambar 6.31 Tampilan Crosstabs pada SPSS
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(nominal atau kategori). Namun untuk kontingensi khusus 
untuk data nominal. Persyaratan penggunaan uji kontingensi 
(C) adalah tidak membutuhkan pengujian awal seperti uji 
normalitas dan homogenitas. Uji ini sangatlah erat dengan 
uji Chi Square, koefisien kontingensi (C) ini tidak dapat 
dihitung tanpa adanya nilai Chi Square. Jadi, harus dilakukan 
perhitungan dahulu nilai Chi Square, baru kemudian hitung 
koefisien kontingensi (C).
Contoh Kasus:

Seorang dokter puskesmas ingin mengetahui hubungan 
keterkaitan jenis kelamin dengan status hemoglobin di wilayah 
cakupannya. Penilaian status haemoglobin (Hb) dilakukan 
dengan melihat kadar Hb melalui hasil pemeriksaan darah. 
Selanjutnya, Status Hb akan dikategorikan menjadi 2 yaitu 
normal dan anemia.

Uji Korelasi140
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Gambar 6.34 Tampilan value labels pada SPSS.

3. 	 Masukkan data pada Data View

Gambar 6.35 Tampilan data view pada SPSS.

4. 	 Lakukan analisis Chi Square dan koefisien kontingensi (C)

Pilih “Analyze” → “Descriptive Statistic” → “Crosstab”
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Gambar 6.38 Tampilan Crosstabs: Statistics pada SPSS.

6. 	 Hasil Uji Koefisien Kontingensi (C)

Tabel “Case Processing Summary” pada kolom “Valid” 
memperlihatkan nilai N yang menginterpretasikan jumlah data 
yang diolah (sebesar 25).  Hal ini sesuai dengan data yang 
diinput pada Data view. Sedangkan, pada kolom “Missing” 
memperlihatkan nilai N yang menginterpretasikan jumlah data 
yang hilang atau tidak diolah (sebesar 0). Hal ini disimpulkan 
bahwa pada uji korelasi ini tidak terdapat data yang hilang atau 
semua data diolah. 
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Row	 :	 Asal_Pendidikan
Column	 :	 Kepuasan_Kerja

Gambar 6.43 Tampilan crosstabs pada SPSS.

5. 	 Pilih “Statistics” 

Pilih “Phi and Cramer’s V” → “Continue” → “OK” 

Gambar 6.44 Tampilan Crosstabs: Statistics pada SPSS.
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Hasil koefisien korelasi Phi didapat nilai sebesar 0,236 
yang berarti memiliki hubungan yang lemah. Sedangkan 
hubungan antara Asal_Pendidikan dengan Kepuasan_Kerja 
dapat dilihat pada nilai signifikansi (approximate significance) 
sebesar 0,292. Dikarenakan nilai sig. 0,292 (p>0,05; α=5%) 
maka dapat disimpulkan bahwa tidak terdapat hubungan yang 
signifikan antara tingkat pendidikan dengan tingkat kepuasan. 

6.8 	 Koefisien Korelasi Cramer’s
Suatu uji yang digunakan untuk menganalisis hubungan 

antara variabel penelitian dengan skala data non-parametrik 
(nominal atau kategori) dengan tabel kontingensi berbentuk r 
(row) x c (column), dimana r atau c lebih dari 2.
Contoh kasus

Seorang kepala klinik ingin mengetahui kepuasan pela
yanan tempat klinik yang dikelolanya kepada pasien yang 
datang berobat ke kliniknya berdasarkan lokasi tempat tinggal 
pasiennya. Penilaian kepuasan pasien dilakukan dengan meng
gunakan kuesioner yang akan dibagi menjadi 3 kategori yaitu 
Sangat Puas, Puas dan Tidak Puas. Sedangkan lokasi tempat 
tinggal pasien dibagi menjadi 2 kategori yaitu Kota dan Desa.
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Gambar 6.46 Tampilan value labels view pada SPSS.

3. 	 Masukkan data pada Data View

Gambar 6.47 Tampilan data view pada SPSS.

Uji Korelasi156
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4. 	 Lakukan analisis sebagai berikut (sama dengan koefisien 
korelasi Phi):

Pilih “Analyze” → “Descriptive Statistics” → “Crosstab”

Gambar 6.48 Tampilan analisis data pada SPSS.

Row	 :	 Lokasi 
Column	 :	 Kepuasan_Pasien

Gambar 6.49 Tampilan crosstabs pada SPSS.
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	 d. 	 Creamer
	 e. 	 Phi 

3. 	 Terdapat tabel kontingensi hasil penelitian:

	 Data dari kedua tabel di atas merupakan data ordinal dan 
tidak berdistribusi normal. 

	 Uji korelasi apakah yang bisa digunakan untuk tabel A 
diatas?

	 a. 	 Creamer 
	 b. 	 Kendall tau B
	 c. 	 Kolmogorov Smirnov
	 d. 	 Pearson
	 e. 	 Kendall tau C 

4. 	 Terdapat tabel kontingensi hasil penelitian :

	 Data dari kedua tabel diatas merupakan data ordinal dan 
tidak berdistribusi normal. 

	 Uji korelasi apakah yang bisa digunakan untuk tabel B 
diatas?

	 a. 	 Kolmogorov Smirnov
	 b. 	 Pearson
	 c. 	 Kendall tau C

Uji Korelasi162
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	 apakah ada hubungan antara berat badan dan tinggi 
badan dalam penggunaan herbal Guazuma ulmifolia dan 
berapakah nilai kuat hubungan tersebut ?

	 a.	 ada hubungan, dengan nilai sig 0,489
	 b.	 tidak ada hubungan, dengan nilai sig 0,489
	 c.	 ada hubungan, dengan nilai sig 0,849
	 d.	 tidak ada hubungan, dengan nilai sig 0,849
	 e.	 ada hubungan, dengan nilai sig 0,948

16.	 Seorang dokter ingin melakukan penelitian untuk 
menganalisis hubungan antara berat badan dan tinggi 
badan dalam penggunaan herbal Guazuma ulmifolia 
dalam mengatasi kegemukan pada remaja. berikut nilai 
yang diperoleh:

Uji Korelasi168
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22.	 Seorang dokter di sebuah klinik ingin mengetahui tingkat 
pengetahuan pencegahan penyakit dengan menggunakan 
herbal terhadap status kesehatan anak – anak di kliniknya 
bekerja. Responden merupakan ibu – ibu yang memiliki 
anak dan rutin memeriksakan anaknya ke klinik tersebut. 
Hasil yang didapat adalah?

	 Apakah terdapat hubungan antara tingkat pengetahuan 
pencegahan penyakit dengan menggunakan herbal 
terhadap status kesehatan anak – anak dan berapakah 
Interpretasi koefisien korelasinya?

	 a.	 ada hubungan, nilai Interpretasi koefisien  korelasi = 
		  0,600 
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28.	 Seorang peneliti ingin melihat ada tidaknya hubungan 
tingkat pengetahuan dari mahasiswa setelah dilakukan 
proses pengajaran dengan metode kuliah online, data 
yang diperoleh sebagai berikut.

	 Bila peneliti ingin melakukan uji korelasi, maka uji yang 
paling tepat digunakan adalah

	 a.	 Uji T-test
	 b.	 Uji Spearman
	 c.	 Uji Anova
	 d.	 Uji Kolmogorov Smirnov
	 e.	 Uji Pearson 

Uji Korelasi180
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32. Seorang peneliti ingin melakukan penelitian dengan 
menganalisis hubungan Berat Badan (kg) dengan lama 
sembuh ketika dirawat di RS (hari). 

	 Berikut data yang diperoleh:

	 *) data diasumsikan berdistribusi normal dan homogen

	 Apakah terdapat hubungan antara Berat Badan (kg) 
dengan lama sembuh ketika dirawat di RS (hari) dan 
berapa kuat hubungan tersebut?
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34. Dokter rumah sakit sehat sejahtera ingin mengetahui 
hubungan tingkat pendapatan pasien dengan pemilihan 
jenis pengobatan. Berikut data yang diperoleh:

	 Keterangan:
	 Pendapatan: 
	 1: Rendah; 	 2: Menengah; 	 3: Tinggi
	 Jenis pengobatan:
	 1: Tradisional; 	 2: Konvensional
	 Buatlah tabel kontingensi dari data diatas
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JAWABAN DAN PEMBAHASAN

1. 	 C
	 Pada penelitian tersebut menyatakan hasil kuesioner me

ngenai kepuasaan pasien terhadap pelayanan tenaga me
dis di Rumah Sakit. Kuesioner kepuasan dan pelayanan 
masing-masing berjumlah 20 pertanyaan, yang setiap 
pertanyaan bernilai 5 poin. Hal tersebut memperlihatkan 
bahwa skala data pada penelitian tersebut adalah para
metrik, sehingga uji korelasi yang tepat adalah uji pearson

2. 	 D
	 Pada penelitian tersebut menyatakan Penilaian dilakukan 

dengan menggunakan dua kuesioner yang berbeda. Hasil 
kuesioner akan dinilai dan dikategorikan. Pengetahuan 
akan dikategorikan menjadi baik dan buruk, sedangkan 
sikap akan dikategorikan menjadi peduli, netral, tidak 
peduli. Hal tersebut memperlihatkan bahwa skala data 
pada penelitian tersebut adalah ordinal. Selain itu, jumlah 
variabel tingkat pengetahuan adalah 2 dan sikap adalah 3, 
maka tabel kontingensinya adalah 2x3.

3. 	 B
	 Pertanyaan di atas menunjukkan tabel kontingensinya 

berjumlah 2x2, serta memiliki skala data ordinal dan 
tidak berdistribusi normal.

	 l 	 Uji Creamer dan Kendall Tau C: Merupakan uji kore-
		  lasi dengan skala data non-parametrik dan tabel kon- 
		  tingensi lebih dari 2.
	 l	 Uji Kolmogorov  Smirnov: Merupakan salah satu uji 
		  normalitas.
	 l	 Uji Pearson: Merupakan uji korelasi untuk skala data 
		  parametrik.
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4. 	 C
	 Pertanyaan diatas menunjukkan tabel kontingensinya 

berjumlah 2x3, serta memiliki skala data ordinal dan 
tidak berdistribusi normal.

	 l	 Uji Kolmogorov Smirnov: Merupakan  salah satu uji 
		  normalitas dengan jumlah sampel lebih dari 50.
	 l	 Uji Pearson: Merupakan uji korelasi untuk skala data 
		  parametrik.
	 l	 Uji Shapiro Wilk: Merupakan salah satu uji normalitas 
		  dengan jumlah sampel kurang atau sama dengan 50
	 l	 Kendall tau B: Merupakan  uji korelasi dengan  skala 
		  data non-parametrik dan tabel kontingensi 2x2.

5. 	 D
	 Pertanyaan diatas memperlihatkan uji yang digunakan ada

lah Pearson (skala data parametrik). Pada hasil uji korelasi 
yang dilihat terlebih dahulu adalah nilai sig. (p value). 
Pada kasus tersebut nilai p=0,000 (p<0,05), sehingga 
dapat disimpulkan terdapat perbedaan. Selanjutnya, 
dilihat besar korelasi yaitu nilai r-nya (r=0,35). Kuat nya 
hubungan korelasi tersebut dapat dilihat pada tabel 6.1.

6. 	 E
	 Pada pertanyaan diatas memperlihatkan data hasil 

kuesioner berupa nilai pengetahuan dan sikap masyarakat 
terhadap program penanggulangan demam berdarah 
berupa angka, sehingga dapat disimpulkan skala data 
penelitian tersebut adalah parametrik. Sedangkan pada uji 
normalitas memperlihatkan nilai p lebih besar dari 0,05 
(p>0,05), yang berarti data penelitian tersebut berdis
tribusi normal. Penggunaan uji yang tepat adalah uji 
pearson, sedangkan uji Spearman, Gamma, Somer’s dan 
Korelasi Phi merupakan uji korelasi untuk skala data non- 
parametrik.
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7. 	 C
	 Pada pertanyaan di atas ingin menguji hubungan penyu

luhan dengan tingkat pengetahuan pada masyarakat di 
suatu desa. Kuesioner yang diberikan adalah sebelum 
dan sesudah dilakukan penyuluhan. Penilaian kuesioner 
tersebut akan dikategorikan menjadi 3 yaitu baik, cukup 
dan buruk. Hal tersebut dapat disimpulkan skala data 
penelitian adalah non-parametrik dan tabel kontingensinya 
adalah 2x3. Selain itu, kedua data memiliki hubungan 
dan berpasangan. Uji yang tepat untuk penelitian tersebut 
adalah uji Kendall Tau C.

8. 	 A
	 Pada pertanyaan tersebut, diminta untuk mengetahui sya

rat dilakukan uji Somer’d, yaitu 
	 l 	Tidak dibutuhkan pengujian awal seperti uji normali- 
		  tas dan homogenitas. 
	 l 	Skala data ordinal/skala data rasio atau interval teta- 
		  pi tidak berdistribusi normal. 
	 l 	Data yang digunakan saling  dipengaruhi  memenga- 
		  ruhi dan antar-variabel terdapat keterkaitan satu sama 
		  lain

9. 	 A
	 Pertanyaan di atas memperlihatkan skala data yang diguna

kan pada penelitian tersebut adalah rasio (parametrik) dan 
juga dilakukan uji normalitas. Penggunaan uji yang tepat 
adalah uji Pearson.

10. 	 D
	 Pertanyaan di atas memperlihatkan skala data yang digu

nakan pada penelitian tersebut adalah nominal (non-para
metrik) dan memiliki 2 kelompok. Penggunaan uji yang 
tepat adalah uji koefisien kontingesi.
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11. 	 E
	 Pertanyaan di atas memperlihatkan 
	 l	 Penggunaan uji Pearson pada  penelitian tersebut, se- 
		  hingga dapat disimpulkan skala data adalah parametrik,
	 l	 Pada  uji  normalitas  memperlihatkan  nilai  p=0,210 
		  (p<0,05), sehingga dapat  disimpulkan data berdistri- 
		  busi normal.
	 l	 Hasil   uji   Pearson   memperlihatkan   nilai   p=0,051 
		  (p>0,05), sehingga  dapat disimpulkan  tidak ada per- 
		  bedaan antara kedua kelompok. Apabila nilai p tidak 
		  ada  perbedaan,  maka  nilai  r  tidak  memiliki  makna 
		  atau uji korelasi tidak dapat diinterpretasikan.

12. 	 B
	 Uji Pearson merupakan uji korelasi yang digunakan pada 

skala data parametrik, sehingga dibutuhkan data yang 
berdistribusi normal melalui uji normalitas. Sedangkan 
pada uji validitas dan reliabilitas biasanya digunakan 
pada validasi kuesioner.

13. 	 E
	 Pertanyaan di atas menampilkan hasil uji korelasi dengan 

menggunakan uji Pearson. Penggunaan uji tersebut 
hanya untuk data dengan skala data parametrik. Pada 
uji Pearson harus melihat nilai p terlebih dahulu, apabila 
nilai p lebih besar dari 0,05 maka disimpulkan tidak ada 
perbedaan antara kedua kelompok. Apabila nilai p tidak 
ada perbedaan, maka nilai r tidak memiliki makna atau 
uji korelasi tidak dapat diinterpretasikan.

	 Pada kasus tersebut nilai sig. (2-tailed) atau nilai p 
memperlihatkan 0,464 (p>0,05), sehingga dapat disim
pulkan tidak ada perbedaan antar kelompok. Oleh karena 
itu nilai Pearson correlation menjadi tidak bermakna. 
Nilai N pada tabel menunjukkan jumlah sampel yang 
telah diuji pada SPSS.
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14. 	 A
	 Pertanyaan di atas memperlihatkan 
	 l	 Pada  uji  normalitas  memperlihatkan  nilai  p=0,319 
		  (p>0,05), sehingga dapat  disimpulkan data berdistri- 
		  busi normal.
	 l	 Hasil   uji   korelasi   memperlihatkan   nilai   p=0,02 
		  (p<0,05), sehingga dapat disimpulkan ada perbedaan 
		  antara kedua kelompok. Apabila nilai p ada perbeda- 
		  an, maka nilai r dapat diinterpretasikan. 
	 l	 Nilai  r  sebesar  -0,832,  memperlihatkan  adanya hu- 
		  bungan antar kedua kelompok.

15. 	 E
	 Hasil uji Pearson memperlihatkan nilai p=0,127 (p>0,05), 

sehingga dapat disimpulkan tidak ada perbedaan antara 
kedua kelompok. Apabila nilai p tidak ada perbedaan, 
maka nilai r tidak memiliki makna atau uji korelasi tidak 
dapat diinterpretasikan.
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	 Hasil diatas menunjukkan nilai Sig.(2-tailed) sebesar 
0,489 (p>0,05; α=5%) maka dapat disimpulkan bahwa 
tidak ada hubungan yang signifikan antara berat badan 
dan tinggi badan dalam penggunaan herbal Guazuma 
ulmifolia.

17.	 C

	 Hasil uji normalitas menunjukkan nilai p value umur 
sebesar 0,993 dan p value penghasilan sebesar 0,855. 
Suatu data dikatakan berdistribusi normal, apabila 
memiliki nilai signifikan p value>0,05. Berdasarkan hasil 
diatas dapat disimpulkan bahwa kedua data memiliki 
distribusi normal.

18.	 D
	 Hasil perhitungan memperlihatkan data berdistribusi 

normal dan homogen, sehingga uji korelasi yang paling 
sesuai adalah uji pearson
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19.	 E
	 Analisis yang digunakan adalah korelasi Spearman karena 

skala data yang digunakan adalah ordinal.

	 Hasil diatas didapat nilai Sig.(2-tailed) yaitu 0,000, karena 
nilai sig. < 0,05 (ꭤ=5%) maka dapat diambil kesimpulan 
ada hubungan antara motivasi kerja dengan prestasi 
kerja. 

	 intepretasi korelasinya dilihat dari nilai koefisien 
spearman sebesar 0,932 yang artinya hubungan sangat 
kuat antara motivasi kerja dengan prestasi kerja. 

20. 	 A
	 Data yang diperoleh jika dibuat tabel kontingensi maka 

hasilnya:

	 Analisis yang digunakan adalah Kendall’s Tau karena 
tabel kontingensi yang dihasilkan adalah 2x2.
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	 Hasil uji :

	 Hasil diatas didapat nilai Sig.(2-tailed) yaitu 0,091, karena 
nilai sig. > 0,05 (α=5%) maka dapat diambil kesimpulan 
tidak ada hubungan antara tingkat kepuasan mahasiswa 
dengan cara mengajar dosen.

21.	 E
	 Data yang diperoleh jika dibuat tabel kontingensi maka 

hasilnya:
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	 Hubungan antara penilaian orang tua murid terhadap pani
tia penerimaan mahasiswa kedokteran dengan kualitas 
kampus dapat dilihat pada nilai signifikansi (approximate 
significance) sebesar 0,108. karena nilai sig. > 0,05 maka 
dapat diambil kesimpulan Tidak ada hubungan yang 
signifikan antara penilaian orang tua murid terhadap pa
nitia penerimaan mahasiswa kedokteran dengan kualitas 
kampus

22.	 A
	 Dari soal diatas jika dibuat tabel kongtingensi maka 

didapat hasil :

	 Karena tabel kontingensi  3 x 2, maka uji korelasi yang 
digunakan adalah Kendall Tau C

	 Hasil analisa yang didapat :
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	 Hubungan antara tingkat pengetahuan pencegahan 
penyakit dengan menggunakan herbal terhadap status 
kesehatan anak – anak dilihat pada nilai signifikansi 
(approximate significance) sebesar 0,002. Dikarenakan 
nilai sig. 0,002 (p<0,05; α=5%) maka dapat disimpulkan 
bahwa ada hubungan yang signifikan. 

	 Hasil Interpretasi koefisien korelasi Kendall Tau c diatas 
didapat nilai 0,600, termasuk hubungan yang kuat 
antara tingkat pengetahuan pencegahan penyakit dengan 
menggunakan herbal terhadap status kesehatan anak – 
anak.

23.	 B
	 Hasil uji normalitas:

	 Hasil uji normalitas memperlihatkan berat badan p 
value=0,735 (sig. 2 tailed) umur p value=0,970 (sig. 2 
tailed). Suatu data dikatakan berdistribusi normal, apabila 
memiliki nilai signifikan p value>0,05. Berdasarkan hasil 
di atas dapat disimpulkan bahwa kedua data memiliki 
distribusi normal, sehingga dapat diambil kesimpulan 
bahwa uji korelasi Pearson dapat dilakukan.
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24.	 C
	 Hubungan antara tingkat pengetahuan dengan status Kese

hatan dapat dilihat pada nilai signifikansi (approximate 
significance) sebesar 0,006. Dikarenakan nilai sig. 0,006 
(p>0,05; α=5%) maka dapat diambil kesimpulan ada 
hubungan yang signifikan antara tingkat pendidikan 
dengan tingkat pengetahuan. Sedangkan hasil uji koefisien 
korelasi Somer’d didapatkan nilai sebesar 0,524, maka 
dapat disimpulkan adanya hubungan yang cukup kuat 
antara kedua variabel.

25.	 B

	 Tabel “Chi-Square Tests” pada Pearson Chi-Square dida
pat nilai Sig.(2-tailed) sebesar 0,002. Dikarenakan nilai 
sig. adalah 0,002 (p<0,05; α=5%) maka dapat disimpulkan 
bahwa terdapat hubungan yang signifikan antara tingkat 
kepuasan lansia terhadap jenis kelamin perawat
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	 Pada tabel “Symmetric Measures” memperlihatkan nilai 
koefisien kontingensi (C) sebesar 0,617, sehingga dapat 
disimpulkan bahwa terdapat hubungan yang kuat antara 
tingkat kepuasan lansia terhadap jenis kelamin perawat.

26.	 E
	 Hasil analisis uji cramer’s

	 Hubungan antara  tingkat pengetahuan dengan jenis 
kelamin mahasiswa dapat dilihat pada nilai signifikansi 
(approximate significance) sebesar 0,117. Dikarenakan 
nilai sig. 0,117 (p>0,05; α=5%) maka dapat disimpulkan 
bahwa tidak ada hubungan yang signifikan antara 
tingkat pengetahuan dengan jenis kelamin mahasiswa.

27.	 D
	 Skala data pada penelitian adalah non parametrik, sehingga 

uji korelasi yang paling sesuai pada data penelitian diatas 
adalah uji Spearman.

28.	 E
	 Skala data pada penelitian adalah parametrik, sehingga 

uji korelasi yang paling sesuai pada data penelitian di atas 
adalah uji pearson.
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29.	 E
	 Nilai signifikansi dari penelitian adalah 0,125 (p>0,05), 

sehingga dapat disimpulkan bahwa tidak terdapat 
hubungan antar-kedua kelompok, walaupun nilai korelasi
nya (r) sebesar 0,7.

30.	 B
	 Salah satu persyaratan uji korelasi pearson adalah data 

berdistribusi normal, sehingga perlu dilakukan uji 
normalitas terlebih dahulu sebelum dilakukan uji pearson.

	 Hasil uji normalitas nilai p adalah 0.066 dan 0,469. Nilai p 
> 0,05 sehingga dapat diambil kesimpulan data penelitian 
berdistribusi normal.

	 Hasil uji homogenitas

	 Hasil uji homogenitas nilai p adalah 0,921. Nilai p > 0,05 
sehingga dapat diambil kesimpulan data penelitian adalah 
homogen.

31. 	 Hasil uji normalitas
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32. 	 Hasil uji korelasi Pearson

	 Hasil uji di atas menunjukkan nilai sig. = 0,000. Karena 
nilai sig < α (0,05) maka dapat diambil kesimpulan 
ada hubungan yang signifikan antara Berat badan (kg) 
dengan lama sembuh ketika dirawat di RS (hari).

	 Tabel di atas menunjukkan nilai koefisien Pearson sebesar 
0,908 yang artinya ada hubungan sangat kuat antara 
Berat badan (kg) dengan lama sembuh ketika dirawat di 
RS (hari).
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33. 	 Hasil uji Spearman

	 Hasil uji di atas menunjukkan nilai sig. = 0,139. Karena 
nilai sig > α (0,05) maka dapat diambil kesimpulan tidak 
ada hubungan yang signifikan antara tingkat kepuasan 
pasien dengan jenis pelayanan yang diberikan. 
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35. 	 Uraian hasil:

	 Nilai sig. (0,764) > α (0,05) maka dapat diambil kesim
pulan tidak ada hubungan yang signifikan dan nilai 
koefisien Kendall_Tau sebesar 0,230 yang artinya ada 
hubungan lemah.

	 Dari tabel di atas menunjukkan nilai koefisien Spearman 
sebesar 0,502 yang artinya ada cukup kuat antara tingkat 
kepuasan pasien dengan jenis pelayanan yang diberikan.

34. 	 Tabel kontingensi
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36. 	 Hasil analisis menggunakan uji Gamma

	 Nilai sig. 0,009 (p<0,05; α=0,05) maka dapat diambil 
kesimpulan bahwa terdapat hubungan yang signifikan 
antara kondisi tempat tinggal dengan status gizi lansia. 
Hasil koefisien korelasi Gamma di atas didapat nilai yaitu 
0,806, maka dapat disimpulkan terdapat hubungan yang 
kuat antara kedua kelompok.
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37. 	 Uraian tabel:
	 Pada tabel ‘Case Processing Summary’ menunjukkan 

nilai N 20 artinya ada 20 data yang diolah.  Hal ini sesuai 
dengan data yang diinput berjumlah 20.  Missing 0 artinya 
tidak ada data yang hilang/semua data diolah.

	 Untuk menentukan hubungan antara tingkat pendapatan 
dengan status gizi balita dilihat pada nilai signifikansinya 
(approx. sig) sebesar 0,765. Karena nilai sig. 0,765 
(p>0,05; α=5%) maka dapat diambil kesimpulan tidak 
ada hubungan yang signifikan. Hasil koefisien korelasi 
Somer’d di atas tidak dapat diberikan penilai.
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38. Hasil analisis:

	 Tabel ‘Case Processing Summary’ menunjukkan nilai N 
7 artinya ada 7 data yang diolah.  Hal ini sesuai dengan 
data yang diinput berjumlah 7.  Missing 0 artinya tidak 
ada data yang hilang / semua data diolah.

	 Pada tabel ‘jenis kelamin * Prestasi kerja Crosstabulation’ 
menunjukkan hasil tabel kontingensi dari data yang kita 
masukkan.
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	 Pada tabel ‘chi square tests’ di atas didapat nilai Sig.
(2-tailed) yaitu 0,659 karena nilai sig. (0,659) > α (5%) 
maka dapat diambil kesimpulan tidak ada hubungan yang 
signifikan antara jenis kelamin dengan prestasi kerja.

	 Pada tabel ‘symmetric measures’ di atas menunjukkan 
nilai koefisien kontingensi (C) sebesar 0,164, artinya 
ada hubungan yang sangat lemah antara jenis kelamin 
dengan prestasi kerja.

39.	 Hasil koefisien korelasi Phi didapat nilai yaitu 0,016, 
termasuk hubungan yang lemah sedangkan nilai signifi
kansinya (approx. sig) sebesar 0,019. Karena nilai sig. 
0,019 < α (5%), maka dapat diambil kesimpulan ada 
hubungan.

40. 	 Hasil analisis:
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	 Tabel ‘Case Processing Summary’ menunjukkan nilai N 
30 artinya ada 30 data yang diolah.  Hal ini sesuai dengan 
data yang diinput berjumlah 30.  Missing 0 artinya tidak 
ada data yang hilang / semua data diolah.

	 Pada tabel ‘Status kesehatan * semangat hidup 
Crosstabulation’ menunjukkan hasil tabel kontingensi 
dari data yang kita masukkan. 

	 Hasil koefisien korelasi Creamer di atas didapat nilai 
yaitu 0,151, termasuk hubungan yang lemah. Pada nilai 
signifikansinya (approx. sig) sebesar 0,712. Karena nilai 
sig. 0,712 >0,05 (α=5%). maka dapat diambil kesimpulan 
tidak ada hubungan yang signifikan antara status 
kesehatan dengan semangat hidup.
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